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EcoDesigner 
Norsk brukermanual 

23.02.11 
 
 
 
 
EcoDesigner er et hjelpeverktøy for å teste ut design og løsninger iht. energiforbruk i en tidligfase og bidrar 
til å ta det første riktige skrittet mot et miljøvennlig bygg. Hovedhensikten med EcoDesigner er å anslå i en 
tidlig fase hvor energieffektivt designet er og den gir muligheter for endring av designet slik at man kan 
forbedre energiresultatene ut fra sluttrapporten som EcoDesigner produserer. 
 
EcoDesigner vurderer også ”Carbon Footprint”. Dette gir en indikasjon på hvor mye CO2-utslipp som 
kommer fra energiforbruket til bygget, altså CO2-utslippet på grunnlag av hvilken metode man velger for 
energi-produksjon; solceller, olje, vannkraftverk, varmepumper, atomkraftverk, kull, propan etc. 
Carbon Footprint tar ikke CO2-utslippet fra materialene med i beregningene. 
 
Alle tall som ligger bak utregningene i EcoDesigner er tilnærmelser og gjennomsnitt vurdert ut fra Europeisk 
standard. Noen av disse verdiene kan overstyres for å gi mer nøyaktig sluttresultat. 
 
EcoDesigner benytter en beregningsmotor som heter VIPCore. Denne beregningsmotoren beregner 
energibalansen og utfører beregningene som sluttrapporten er basert på. Man bør også merke seg at ca. 
80% av valgene arkitekten tar under designfasen bestemmer byggets energieffektivitet, mens ingeniøren 
bidrar kun med ca. 20%. 
 
EcoDesigner kan kjøres i: 

- Windows XP, Vista og 7 
- MacOS 10.4 eller bedre 
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1. Bygg opp en riktig BIM-modell 
 
ED benytter beregningsenhetene fra ArchiCAD. For å endre disse: 
 
Options > Project Preferences > Calculation Units 
 
 

1. Bruk riktig verktøy til å tegne de ulike delene av bygget: vegger, dekker, tak og Curtain Walls (bruk 
for eksempel ikke terreng til å tegne tak). 
 

2. Alle konstruksjoner bør defineres til enten innvendig eller utvendig konstruksjon. Hvis man for 
eksempel har et dekke som er begge deler er man nødt til å splitte det opp i to dekker, et innvendig 
og et utvendig. 
 

3. Ikke bruk flere enkeltvegger (dekker eller tak) for å lage de ulike sjiktene i en vegg. Veggen skal 
lages i Composite Structures i ArchiCAD.  
 
Options > Element Attributes > Composites 
 

4. For å evaluere en bestemt del av bygningen med EcoDesigner benyttes Marquee Tool. 
 
 
2. EcoDesigner-analyse 
 

1. Åpne EcoDesigner. 
 
Design > Design Extras > EcoDesigner 
 

2. ED utfører automatisk en modellanalyse for bygget og summerer de ulike konstruksjonene i to 
grupper. Trykk OK. 
 

 
 
 



 
Graphisoft Norge 
Fridtjof Nansens vei 17, 0369 Oslo Tel: (+47) 21 55 58 00   Utarbeidet av sivilingeniørstudent Natalia Marszalek 
Org:  NO 863 355 052 MVA Fax: (+47) 21 55 58 01   natalia@graphisoft.no  

3 

3. EcoDesigner har fire ulike hovedinnstillinger 
 
 
Location & Function (Beliggenhet og funksjon) 
 

  
 
1. Velg by beliggenhet for bygget 
 
2. Himmelretning (taste inn manuelt eller dreie på pilen) 
 
3. Høyden i forhold til nullnivå  
 
4. Vindskjerming 
 
5. Omgivelser 
 
6. Fasadenes skyggeforhold 
 
7. Byggets funksjon 
 
8. Flere funksjoner (hvis bygget benyttes til flere funksjoner) 
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1. Definer hvor bygget befinner seg. Man kan velge forskjellige byer ut ifra en liste, eller man kan 
taste inn lengde- og breddegrader dersom man ikke finner stedet man ønsker i listen. Klimadataene 
lastes ned fra internett. 
 
For å legge til et nytt sted: 
- Skriv inn navnet på stedet 
- Tast inn lengde- og breddegrader og tidssone 
- Trykk Add 
- Kontroller at klimadataene ble riktig lastet ned (den grønne sirkelen) 
 
Klimadataene inneholder: 
Lufttemperatur, Relativ Fuktighet, Vindhastighet og Solstråling 
 
Klimadataene er lastet opp fra Strusoft:  http://climate.vipenergy.se 
Klimadataene er hentet fra:   http://www.cdc.noaa.gov/  
Klimadataene lagres i ArchiCAD Cache Library, så nedlastet data forblir lagret til neste prosjekt. 
 
 

 
 
2. Himmelretningen er den samme som er stilt inn på:  
 
View > 3D View Mode > 3D Projections Settings > More Sun > Project North 
 
3. Hvor høyt bygget ligger i forhold til terrenget  
 
4. Bestem byggets vindskjerming 
 
5. Bestem byggets omgivelser. Omgivelsene bestemmer graden av refleksjon av solstråling fra 
omgivelsene rundt bygget, indirekte solstråling på fasaden   
 
6. Her bestemmes skyggeforholdene på de enkelte fasadene på bygget, samt kompleksiteten til 
fasadene. Hovedgrunnen for å bestemme kompleksiteten på fasadene er; jo, er kompleks fasade, 
desto mer skygge kaster utstikkene på fasaden. Legg merke til de to figurene øverst. Disse 
illustrerer forandringene du foretar deg på hver fasade. Du kan også velge tak utstikk.  
 
Ønsker du å redigere disse innstillingene se side 34 i Graphisoft EcoDesigner User Guide under 
help menyen. 
 

http://climate.vipenergy.se/
http://www.cdc.noaa.gov/
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7. Bestemmer byggets funksjon. Ut fra byggets funksjon har EcoDesigner ulike temperaturprofiler 
(legg merke til at grafene endrer seg når man endrer funksjonen til bygget) 
 
Ønsker du å redigere disse innstillingene se side 36 i Graphisoft EcoDesigner User Guide under 
help menyen. 
 
 
8. Man kan definere bruken til bygget mer spesifikt. Her kan man bestemme at bygget brukes til flere 
formål, for eksempel at 30% benyttes til Bolig, 20% benyttes til Restaurant-Cafe og 50% benyttes til 
Butikk-Kjøpesenter. 
 

 
 
Structures (Oppbygning) 
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1.   Modellkontroll 
 
2.   U-verdi [W/m

2
K] / U-verdikalkulator 

 
3.   Utvendig kledning (sol absorpsjonsfaktoren) 
 
4.   Infiltrasjon [l/sm

2
] 

 
5.   Ta bort areal mindre enn 
 
6.   Bruttoareal (BRA) [m

2
] 

 
7.   Bygningsvolum [m

3
] 

 
8.   Innvendige konstruksjoner  
 
9.   Isolasjon i grunnen  
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1. ED grupperer alle konstruksjonene i seks kategorier og tildeler dem ulik farge. Dette vises i Model 
Review som tildeler modellen farger etter de ulike kategoriene konstruksjonen har blitt fordelt i, etter 
Automatic Model Analysis som utføres når man starter ED: 
 
 
 
 

    
 
 

- Tak og gul mot klima 
- Utvendige vegger 
- Gulv på grunn 
- Kjeller-vegger  
- Kjeller-gulv 
- Innvendige konstruksjoner 
 
 
For å få frem fargene på bygget er man nødt til å være i en Model View som har Mark-Up huket av, 
for eksempel Arbeidstegning. For å endre fargene til de ulike gruppene: 
 
Option > Element Attributes > Markup Styles 
 
 
 
 Her er det viktig at man går inn og kontrollerer om alle konstruksjonsdelene er i riktig gruppe.  
 
Model Review dialogboks 
1. Velg alle elementer i den valgte gruppen 
3. Marker valgt element(er) på modellen 
3. Av-marker valgt element(er) på modellen 
4. Vis beregningsvolum 
5. Analyser modell (Reset-knapp for markering av modellen, går til opprinnelig EcoDesigner analyse) 
 
I Building shell elements-listen grupperes like vegger på en fasade som har lik tykkelse, skravur og 
oppbygging i en rad. For å gruppere like rader trykk på knappen med overskriften til kolonnen, man 
kan da sortere etter ønsket kategori. 
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2. For å redigere U-verdiene, gå inn i U-verdikalkulatoren. 
 

 
 
  
 
U-verdikalkulator 
  
1. Thermal Properties Assignment 
 
2. Utvendig varmeovergangsmotstand 
 
3. Innvendig varmeovergangsmotstand 
 
4. Kuldebro 
 
5. U-/R-verdi resultat 
 
6. Overstyr U-/R-verdi 
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I U-verdikalkulatoren er det viktig å bestemme alle materialene i de ulike sjiktene i konstruksjonen for 
å oppnå riktig U-verdi. Man kan velge ulike materialer fra en liste som ligger inne i ED ved å trykke 
på boksen under punkt 1. Da får man opp et vindu som heter Thermal Property Assignment(pkt.1). 
Her får man oversikten over alle skravurer som representerer de ulike materialtypene. 
 
  

 
 
 

B: Man kan også importere/eksportere de termiske egenskapsdataene man har for det enkelte 
bygget. Dette valget er viktig hvis flere personer regner på det samme bygget og ønsker å benytte 
de samme materialene. 
 
For de fleste sjikt linkes automatisk et materiale direkte. Man bør uansett gå inn å se etter om de 
ulike sjiktene har de riktige materialene som en ønsker å benytte. 
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A: Her får man opp et vindu som inneholder en liste over de ulike materialene som ligger inne i 
EcoDesigner, Material Catalog, og her velges det materialet man ønsker å benytte i det valgte sjiktet. 

 

 
 

Hvis man ikke finner et tilnærmet materiale som man ønsker å benytte kan man overstyre verdiene 
direkte i Thermal Properties Assignment. Dersom man overstyrer et skravur blir alle sjiktene med det 
skravuret endret til de verdiene man overstyrer med. 
 
Materialet defineres ved 3 konstanter:  
Varmekonduktivitet (λ) [W/mK], Tetthet [kg/m

3
] og Varmekapasitet [J/kgK] 

 
 
 
3. Bestemmer sol absorpsjonsfaktoren for hver enkelt fasade avhengig av hva slags kledning det er 
på fasaden. 
 
 
4. Bestemmer graden av infiltrasjon, fire kategorier er tilgjengelige i nedtrekks-menyen.  
 
 
5. Ønsker man å utelukke noen mindre arealer på bygget. Taster man maks tillatt betraktet areal, 
alle flatene som har mindre areal enn dette forsvinner da fra Building shell elements-listen. 
 
 
 6 og 7: Bruttoareal og Bygningsvolum opprettes automatisk fra modellen av bygget. De kan 
overstyres. 
 
 
8. Her er tre valg for å bestemme hva slags materialer de innvendige konstruksjonene består av, slik 
at disse også blir tatt med i beregningene.  
Tetthet x Innvendig konstruksjonsvolum. 
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9. En viktig ting man bør merke seg er at Floors on ground ikke dukker opp i Building shell elements-
listen. Grunnen til dette er at man benytter en annen regnemetode for gulv på grunn. Man 
bestemmer ikke U-verdien på gulv på grunn, men isolasjonstypen og isolasjonstykkelsen (b 
nedenfor) i Underground Insulation. Man velger isolasjonsmaterialet ut ifra en liste, trykk på ikonet 
ved under a. 
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Openings (Åpninger) 
 

 

 
 

  
 

1. Åpninger i klimaskallet 
  
2. Vindu og dør katalog  
 
3. Solavskjerming 
 
4. Hvor mange prosent glass utgjør av åpningen 
 
5. U-verdi [W/m

2
K] 

 
6. Total Soltransmittans  
 
7. Infiltrasjon 
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1. I Openings on building shell listen er alle like vinduer/dører under en rad, fordelt på de ulike 
fasadene. 
 
 
2. I denne listen kan man velge det vinduet man måtte ønske. 
 

 
 

Forklaring for vindu definering i EcoDesigner, eksempel: 
 
WOOD/4-12-4-12-4/COATING e=0,05/ARGON 
 
WOOD: Vindusinnramming 
4-12-4-12-4: Vindu lag 4mm glass, 12mm luft, 4mm glass, osv. 
COATING e=0,05: Utvendig glasslag er behandlet med Low-E. (Jo lavere desto bedre U-verdi) 
ARGON: Gassen man fyller luftspaltene mellom glasset med. 
 
 
3. Velge hva slags solavskjerming man ønsker å benytte på dørene og vinduene. Dette velger man i 
EcoDesigner istedenfor å tegne det på selve modellen. 
 
4. Hvor mange prosent glass utgjør av vinduet/døren – kan overstyres 
 
5. U-verdien til vinduet/døren – kan overstyres 
 
6. Total soltransmittans; hvor stor del av solstrålingen som treffer vinduet som tilføres bygningen 
– kan overstyres 
 
7. Infiltrasjon til dørene/vinduene – kan overstyres 
 
 
Dersom man ikke finner den døren/vinduet man ønsker å benytte i EcoDesigner åpningskatalogen, 
kan man besøke produsentenes hjemmesider eller produktkataloger og finne disse verdiene for det 
vinduet man velger og overstyres disse i EcoDesigner. 
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MEP Systems & Energy (VVS/EL-Systemer & Energi) 
 
  

 
 
 
 
 
 
 
1. Varmt- og kaldtvannstemperatur 
 
2. Kjølingssystem 
 
3. Ventilasjonssystem 
 
4. Oppvarming 
 
5. Interiørlys 
 
6. Energikilder og priser 
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1. EcoDesigner har standardverdier for vann, laveste og høyeste temperatur. Disse kan overstyres 
manuelt og vises i Celsius eller Fahrenheit. Disse temperaturene benyttes for å estimere 
energiforbruket knyttet til varmtvannsbehovet. 
 
2. Man har tre valg for kjølesystem; naturlig, mekanisk kjøling (Air Condition) og siste valg avkjølt luft 
som hentes fra en ekstern kilde 

 
3. Man har tre valg for ventilasjon; naturlig ventilasjon, avtrekk (kun) og tilføring og avtrekk. Man 
bestemmer også antall luftskift i timen (for eksempel TEK07 = 2,5 ganger i timen, § 8-21 a). 
 
6. Her bestemmes hvordan energibehovet ønskes fordelt. Man kan bestemme hva slags 
strømproduksjon elektrisiteten til de ulike formålene hentes fra (A). Med litt kunnskap kan man lett 
bestemme miljøvennlige metoder å produsere strøm på, dette vil gi utslag på CO2-forbruket og 
energiforbruket til bygget. Man kan også bestemme valuta (B) og pris(C) på strømmen fra de ulike 
strømkildene. Legg også merke til at man kan få prisen i ulike benevninger, trykk på benevningen 
som ønskes endret. Det siste valget i dette vinduet er hvordan elektrisiteten blir produsert. 
 
Eksempel: 
ManVi ønsker å benytte kun elektrisitet til oppvarming = 100% 
Strøm til annet elektrisitetsforbruk i bygget ønsker man å benytte elektrisitet = 80% og pellets = 20% 
Elektrisitet produseres med vannkraft. 
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MEP Systems & Energy (VVS/EL-Systemer & Energi), 
 

 
 

1. Solfanger 
 
2. Varmepumpe 
 
3.Varmegjenvinningssystem 
 
4.Eksport til VIP-energy se side 23. 

 
1. Solpanelareal. Hva energiproduksjonen skal benyttes til, vinkel mot syd og tiltningsvinkelen.  
 
2. Her velges kilde til varmepumpen, kapasiteten og hva energiproduksjonen fra varmepumpen skal 
benyttes til. 
 
3. Man kan bestemme varmegjenvinningssystem fra ventilasjonsluften. Plate-, roterende- og 
væskekoblet-varmegjenvinner. Man bestemmer også effektiviteten for varmegjenvinneren  
(se TEK07). 
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Beregning 
 
Når man har huket av alle ønskede alternativer og tilpasset bygget i EcoDesigner, har man tatt første 
skritt for å teste bygget og få ut en sluttrapport for å se hvordan designet og valgene av konstruksjoner 
vil slå ut. 
 

 
 
 
Trykk på Start Evaluation 
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Nå får man opp rapporten som viser resultatene av designet og alle valgene man har foretatt i ED. 
Er man misfornøyd med resultatet kan man lett gå tilbake og endre innstillingene i ED, på Back to 
EcoDesigner. Når man ønsker å gå tilbake og endre på modellen/designet i ArchiCAD, trykker man 
på Close. Man kan også lagre rapporten som PDF. 
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Når man ønsker å gå tilbake til modellen i ArchiCAD, trykker man på Close. 
 

 
 
 

For å beholde innstillingene i EcoDesigner, trykk Store. 
 For å ikke lagre siste innstillinger trykk Don’t Store. 
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Beregning 
 
 Beregningsmotoren VIPCore utfører dynamiske energianalyser. EcoDesigner beregner 
energiforbruket for bygget time for time i løpet av et år. Beregningene fra EcoDesigner har blitt testet 
opp mot allerede oppførte prosjekter og gitt gunstige resultater.  
 
Energibalansen i sluttrapporten består av: 
Tilført energi: oppvarming, soloppvarming, varmegjenvinning, innvendig varme (pc, lamper, 
personer) og elektrisitet   
Avgitt energi: transmisjon, infiltrasjon og varmtvannskjøling 

 
EcoDesigner benytter samme beregningsmotor som VIP Energy. VIP Energy er testet i forhold til 
EN-15265 og europeisk standard for energiberegninger EN-13790. 
 
For mer informasjon om beregningsmetodene bak EcoDesigner, se EcoDesigner Manual i 
ArchiCAD: 
 
Help > Graphisoft EcoDesigner User Guide 
 
 
Lisens 
- ED er beskyttet av ArchiCAD’s WIBU/CodeMeter-nøkkelsystem  
- Dersom man har en nettverksnøkkel på ArchiCAD, men kun enbruker lisens på EcoDesigner, må 
man fjerne haken for EcoDesigner i Add-On Manager og deretter restarte ArchiCAD for at en annen 
bruker skal kunne bruke EcoDesigner  
 

 
 
 
For mer info om EcoDesigner:  
 
http://www.graphisoft.com/products/archicad-solutions/ecodesigner/  

http://www.graphisoft.com/products/archicad-solutions/ecodesigner/
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Export av inndata (.vut) fra EcoDesigner til VIP-Energy 
Beskrivelse og vurdering 
 
 

 
 

 
 
 
 
 
 
VIP-Energy er et beregningsprogram som gir muligheten til å studere resultatene fra EcoDesigner nøyere, 
men er også et selvstendig program hvor man kan taste alle inndata inn manuelt dersom man ikke benytter 
ED. VIP-E. er et godkjent program som kan brukes til å dokumentere energibehovet for bygg i Norge. Den 
norske versjonen av VIP-E. som jeg benytter til sammenligning av resultater, bruker beregningsmodellene 
etter NS3031:2007, og sammenligner resultatene mot TEK 2007. VIP-E. er ikke ment for dimensjonering av 
varme- eller kjølesystemer, programmet er optimert for beregning av energibehov i bygninger. 
 
Eksport fra ED til VIP-Energy er en enveis eksport (kun fra ED til VIP-Energy). Eksportfilen fra ED inneholder 
informasjon som kommer automatisk inn i VIP-E ved import. Mange av dataene vi ikke kan se direkte i ED 
blir overført detaljert inn i VIP-E, slik at man lett kan kjøre beregningene basert på tallene fra ED og studere 
de spesifikke resultatene, istedenfor å taste alle dataene inn manuelt. 
 
Hovedideen med ED er at arkitekten skal få muligheten til å designe bygget slik han selv ønsker, samtidig 
som han kan ta egne designbeslutninger basert på energitiltak i en tidligfase ved enkel vurdering av 
sluttrapporten i ED. Hensikten med eksport til VIP-E. er at arkitekten allerede i en tidligfase har tatt en rekke 
valg basert på energieffektivitet, slik at ingeniøren lett kan studere alle interessante data og vurdere de ulike 
tiltakene som arkitekten har gjort. I VIP-E. får man også muligheten til å taste inn flere tall som kan ha en 
betydning for vurdering av energibehovet for det enkelte prosjektet. 
 
Eksportfilen .vut fra ED kan kun importeres i VIP-E. Man bør også legge merke til at man kan benytte 
ArchiCAD som et bindeledd mellom andre formater og .vut. Ideen bak dette er at dersom man har bygget 
opp prosjektet sitt i et annet program, kan man eksportere det via en IFC-fil til ArchiCAD og dermed 
eksportere den via ED videre til VIP-E.  
 
Forskjellen mellom ED og VIP-E. er beregningsmodellene. ED benytter internasjonale beregningsmodeller 
mens VIP-E – Norsk benytter NS3031:2007. Dermed får vi et avvik i sluttresultatene. Nedenfor har jeg gjort 
noen forsøk for å sammenligne tallene mellom VIP-E. og ED. 
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U-verdier etter norsk standard 
 
Varmeovergangsmotstander er avhengig av varmestrømsretning: Oppover, horisontalt og nedover. ED har 
standardverdier for dette som er basert på internasjonale gjennomsnittlige/tilnærmede tall. 
 
For å få U-verdier til å stemme etter norsk standard kan man velge å benytte tall etter NS-EN ISO 6946 som 
er anbefalt av BYGGFORSK, HÅNDBOK 35, (for andre verdier se NS-EN ISO 6946 eller HÅNDBOK 35): 
 

 
ED benytter ligningen nedenfor for å regne ut U-verdien til veggen. I tillegg kommer kuldebroverdien (∆U) inn 
i bildet:  
 
 
 

  
 
 
 
 
 
De fleste kjenner denne ligningen bedre som: 
 
U [W/m

2
K] = 1 / RT + ∆U = 1 / (Rsi + R + Rse ) + ∆U 

 
R   = varmemotstand 
∆U = kuldebro, her 0,03 W/m

2
K 

 
hvor R [m

2
K/W] = d / λ  

 
d = Sjikt tykkelsen [m] 
λ = Varmekonduktivitet [W/mK] 
 
Til høyre ser vi ligningen til EcoDesigner og dette er 
samme ligning bare skrevet på en annen måte 
(Ligningen til høyre inkluderer ikke kuldebro, kun U-verdi). 
 
 
 

 EcoDesigner NS-EN ISO 6946 

  VEGG TAK 

External heat transfer coefficient 24 W/m
2
K 25 W/m

2
K 25 W/m

2
K 

Internal heat transfer coefficient 10 W/m
2
K 8 W/m

2
K 10 W/m

2
K 
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Når modellen er riktig oppbygd i EcoDesigner og man har kommet så langt at vurderingen i EcoDesigner gir 
et fornuftig og godt resultat, kan man eksportere modellen over til VIP-Energy. 
 
  
Eksport til VIP-E.: 
 
1. Trykk ”Export to VIP-Energy” i EcoDesigner. 
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2. Lagre EcoDesigner.vut på en valgt plassering (man kan bytte navn på filen) 
 

 
 
Import i VIP-E.: 
 
1. Åpne VIP-E. 
 

 
 
 
2. Inndata > Norm > Norsk Norm NS3031:2007 > Trykk OK. 
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3. Fil > ArchiCAD Import > Velg den lagrede EcoDesigner.vut > Åpne. 
 

 
 
4. Det skjer ingen synlig endring i VIP-E., endringene ligger inne der man taster inn-inndata. For å studere 
de ulike import inndata som har blitt importert: 
 
Inndata > Bygning. 
 

 
 
 
 
Inndata > Tekniske Installasjoner. 
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5. Ønsker man å gjøre en beregning uten forandring av inndata: 
 
VIP-E regner etter NS3031:2007, dermed trenger man å velge den riktige klimafilen for disse beregningene. 
 
Inndata > Klima og generelle inndata > Klimadata REF_NS3031 > OK 
 

 
 
For å gjøre en beregning slik at den kan dokumenteres etter NS3031:2007 er man nødt til å benytte et 
konstruert referanseår basert på Oslo-klima, REF_NS3031.  
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Har man et ønske om å benytte samme klimafil som i ED, er man nødt til å hente den manuelt:  
 

 
 

1. Pakk ut alle filene i mappen. 
2. Filnavnet består av bredde- og lengdegrad.  
3. Kopier filen til et annet sted. Man velger filen etter bredde- og lengdegradene. 
4. Inndata > Klima og generelle inndata > Legg til klimafil > Velg filen du kopierte *.vipclimate > Åpne 
5. Trykk OK 

 
 
6. Da er alt klart for første beregning. Lagre beregningen på en valgt plassering. 
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7. Velg beregningsperiode > Her 365 dager > Beregn > Trykk OK. 
 

 
 
8. Man får automatisk opp energibalansen basert på data fra ED, dersom man ikke har gått inn og forandret 
på inndataene. Grafen er fordelt pr uke.  
 

 
 
9. For å få grafen mest mulig lik grafen fra ED sluttrapporten må man fordele intervallene på måneder: 
 
Resultat > Energibalanse > Måned 


